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1. Home

Welcome to the LightBurn Docs!

Please use the search bar at the top of the page or click the closest match below to find information on the tool or topic you'd like to learn
about.

You can make LightBurn feature requests on our suggestion site.

Disclaimer and Safety

Troubleshooting

Connection Problems

Job Quality

LightBurn Editor FAQ

GRBL Errors

License Activation and Management

Beginner Pathway

Installing LightBurn

Adding Your Laser to LightBurn

How to Use LightBurn

Zooming, Panning, and Selection

Getting Started: Making a Simple Project

Coordinates, Device Origin, and Job Origin - Placing your work

Primary Documentation

Instructions on Commonly Used LightBurn Features

Cool Tricks and Usability Tips

Working With Fusion 360

LightBurn Bridge Docs

Using a Rotary

Galvo Docs

If you need to read our documentation in a different language, you can use Google Translate to translate this website into your preferred
language.

For your convenience, we have shortcuts to Google translate for Spanish (Español), German (Deutsch), Italian (Italiano), Chinese (漢語), and 
French (Français).

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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2. How the License Works

2.1 How the LightBurn License Works

A LightBurn license is a digital key used to unlock the software for permanent use.

Every new license comes with a year of free updates from the date you first activate it. After a year, you'll still be able to use any version of
LightBurn released before your license expired, but you'll need to renew your key in order to continue receiving updates for another year. If
you renew before your key expires, you'll receive an additional two months on your one-year renewal. 

The version you need depends on the type of controller used by your laser. LightBurn supports three device types: GCode, DSP, and Galvo. If
you're not sure what type of license you need, see Which Version Do I Need?

If you started with a license that supports one type of device, and now need to use LightBurn with a different type, you can add support for
the new device type to your existing key. Please note that adding support for additional devices does not renew your key.

A LightBurn license automatically comes with 3 seats, meaning you can activate it on three computers at one time. You can use our License
Portal to view and remove activations on your key, freeing up activations in use on old or inoperable computers so you can activate on new
ones. 

If you already have a key, you can purchase additional seats here. If you would like to purchase a new key with more seats than the default of
3, or are interested in a Floating license setup, see our Educational and Volume Licensing page.

If you sell your laser and wish to sell your license along with it, that is permitted. Please note that it is not permitted to sell part of your license
to someone else.

Have questions? Visit our FAQ or contact us at support@lightburnsoftware.com

2. How the License Works
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2.2 Licensing FAQ

No. You pay once, and the software will work forever as long as you have your license key.

LightBurn supports three device types: GCode, DSP, and Galvo. If you're not sure what type of license you need, see Which Version Do I Need?

All DSP and Galvo keys also support GCode devices.

Yes, the same key can be used to activate LightBurn on Windows, MacOS, or Linux. 

A LightBurn License automatically comes with 3 seats, meaning you can activate LightBurn on 3 computers at one time. You can use our License
Portal to manage your activations. 

If you'd like to activate LightBurn on more than 3 computers, you can purchase additional seats for your license here. The cost of each additional
seats depends on your license type.

If you would like to purchase a new key with more seats than the default of 3, or are interested in a Floating license setup, see our Educational
and Volume Licensing page.

No, but your license's update period has an expiration date — a year from when you first activated it. When the update period ends, the key is
still valid, but you won't be able to use any version of LightBurn released after the end of the update period. Any version released before the key
expired will continue to work. 

To download and revert to a version of LightBurn compatible with your key, visit Releases. 

If your key has expired, a renewal will add a year of updates, starting from the date you purchase the renewal.

If you renew before your key expires, the renewal period will be extended starting from the date your key was set to expire. You'll also receive an
additional two months on your one-year renewal.

The price to renew your license's update period and receive another year of software updates is $30. Renew your license here.

No. The price of a renewal is the same regardless of the number of seats on your license.

Is a LightBurn license a subscription?

Which version do I need?

Can I use the same license key on any operating system?

How many computers can I use it on?

Does the license expire?

My license expired, how do I revert to a compatible version of LightBurn?

How do renewals work?

How much is it to renew?

Do renewals cost more if I have more than 3 seats on my license?

2.2 Licensing FAQ
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Yes. Enter your key on the checkout page for the type of device support you need to add to your key. Add DSP support to your key here. Add
Galvo support to your key here.

No. A license upgrade adds supported device types to your key, but doesn't take any away. 

No. Adding support for a different device type does not renew your key, or affect your key's update period in any way.

Yes. If you are already have a LightBurn license, but would like to try it with a device type your key does not currently support, go to Help ➝ 
License Management and click Deactivate License, then Extend Trial.

Our systems are fully automated, and all upgrades are processed promptly. However, LightBurn will need to contact our licensing server to
register any upgrade, and it can take up to 24 hours for LightBurn to sync with the server. You can force LightBurn to check back in by
deactivating and then reactivating your key in the License Management window. 

If you've already activated your license, but aren't sure if it supports your type of laser, go to Help ➝ License Management to see a list of device
types supported by your license. 

If you're unsure whether your laser is one of the types listed, see Which Version Do I Need?

If you're unable to connect to your laser even though it is supported by your license, see Troubleshooting: Connection Problems. 

Yes. You are free to transfer your key to another user, or sell it along with your laser. The recipient will need to contact us with the key in order for
us to transfer it to their email address, granting them access to our License Portal. 

Please note that selling or sharing individual seats on your license key is not permitted. Keys must be transferred in their entirety, including all
seats. 

Can I add support for a new type of laser to my existing key?

Will I lose support for other devices when upgrading?

Does adding support for a different device type renew my key?

I already have a LightBurn license. Can I try a different version before upgrading?

How do I know when my upgrade has been applied?

How do I know if my license supports my laser?

Can I transfer my key to another user?

2.2 Licensing FAQ
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Primary Docs

2.3 License Management

The license system used by LightBurn has a web portal where you can view the computers activated on your license, deactivate unused
computers, or process an Offline Activation. 

If you purchased your key from LightBurn directly, you will have access to this portal. If you purchased from a 3rd party vendor, we will need
to assign your license key to your email address for you to gain access. Contact us at support@lightburnsoftware.com with your full name and
license key to have us do so. 

Accessing the License Portal

The Cryptlex web portal has been updated. The old URL (http://lightburn.cryptlex.app) will continue to work through August 31, 2024. Please
update any bookmarks to reflect the new URL.

The first time you use the portal you will need to enter the email address assigned to your key and request a password reset.

Follow these instructions to access the License Portal:

Go to https://lightburn.customer.cryptlex.com/.

Click Forgot Password.

Enter the email address where you received your license key, and click Send Reset Link.

You will receive an email from Cryptlex with a password reset link.

Follow the link, choose your new password, then log in.

If you do not see an email from Cryptlex, check your Promotions or Spam folders — the password reset email sometimes ends up there. If you
still cannot find it, your email provider might be blocking the email from ever reaching you. Contact us at support@lightburnsoftware.com to
have us reassign your key to an address under a different provider. Gmail accounts work well.

Removing an Old Computer From Your Key

If you still have access to the computer you wish to remove from your license: 

Open LightBurn on that computer and go to Help → License Management.

Click Deactivate License.

New Cryptlex Web Portal

1. 

2. 

3. 

4. 

5. 

Note

1. 

2. 
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If you no longer have access to the computer you wish to remove: 

Log in to the License Portal. On the main screen you will see any licenses associated with your email address.

Click on Activations in the left sidebar to view a list of computers assigned to your license key, when they were last used (Last Synced At), and
when they were first activated (Creation Date). 

Click the three dot icon to the right of any computer in the list, to show the option to Delete that computer, removing the license from that
computer, and freeing up the license seat for use on another machine. 

1. 

2. 

3. 

2.3 License Management
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Processing an Offline Activation

Follow the steps below to activate LightBurn on a computer without access to the internet. 

Enter your license key in the License Management window.

Click Request Offline Activation.

You'll be asked to save a file with an .ofr extension that contains the machine fingerprint as an offline request. Save and copy that file to a USB
flash drive and bring it to a machine with a network connection. 

Log in to the License Portal on the machine with a network connection.

While viewing your license in the portal, click Activations.

Click Create Offline.

Paste your key into the License Key field.

Click in the Offline Request field to open your system's file browser, navigate to the location the .ofr file is saved, and select it.

Click Activate.

1. 

2. 

3. 

4. 

a. 

b. 

c. 

d. 

e. 

2.3 License Management
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You'll see Task Successful if you entered everything properly. Click Download to download the .dat response file.5. 

2.3 License Management
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If you see an Invalid license id message instead, you'll need to repeat the process. Take care to enter your exact license — including hyphens —
into LightBurn and the field in the Offline Activation window. Copying and pasting the key directly from your original order email is the best way to
ensure accuracy. 

Transfer the .dat file back to the offline computer by USB flash drive.

On the offline computer, in the License Management window in LightBurn, click Process Offline Activation. 

Navigate to the location the .dat response file is saved and select it, completing the Offline Activation process. 

Warning

6. 

7. 

8. 

2.3 License Management
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If you're not comfortable performing all of the above steps yourself, email us at support@lightburnsoftware.com, with the .ofr file and
license key, and we will process the file and return the .dat response file for you to use to complete the activation. 

It is not possible to complete this process for a Trial ID. LightBurn must connect to the internet once to activate a trial, after which you are free to
take your computer back offline.

Warning

2.3 License Management
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2.4 System Locked and Floating License Setup

System Locked and Floating licenses are advanced licensing setup options, often required for installations of LightBurn in shared spaces such
as school computer labs.

A System Locked license is locked to the computer it is activated on, allowing all users on the same computer to use the same license without
sharing login info. Any LightBurn key can be set up as System Locked.

A Floating license is managed by our license server, allowing the license to be allocated when a LightBurn session is started and released
when the session is closed. This is intended for environments such as school computer labs where a greater number of computers will need
to be activated than instances of LightBurn will be used at once. Your key must be specially tagged as a Floating type in order to utilize this
setup option. 

See our Educational and Volume Licensing calculator or contact us via email if you would like to learn more about volume licensing options. 

2.4.1 System Locked License Setup

Windows

Make sure LightBurn is installed and activated as normal, then
close out of the program, or the rest of the process will not work.

Open up a Command Prompt window:

Click the Start menu, then type "CMD".

Windows will automatically find the Command Prompt app as the
best match. Right-click it and select Run as administrator.

Type the following into the command prompt:

Next, type the following into the command prompt:

Enter a lowercase letter L, and not the number 1. Enter your key,
without the parentheses, where it says "(license key code here)". 

Mac

Make sure LightBurn is installed and activated as normal, then
close out of the program, or the rest of the process will not work.

Open up a Terminal window.

Press ⌘ + Space  then type "Terminal". 

Click Terminal to open it.

Type the following:

Enter a lowercase letter L, and not the number 1. Enter your key,
without the parentheses, where it says "(license key code here)".

Once you've completed this process, all users on the same
computer will be able to use LightBurn without activating the key
individually. 

2.4.2 Floating License Setup

Activation

In order to set up a Floating license, first follow the above
instructions on setting up a System Locked license.

Once you've run the command line process successfully on one
system, you can copy the "lightburn.ldata" file from the
LightBurn program folder on that system to the same location
on other systems you want to use the license, so you can avoid
having to type the command line on the rest.

Network Restrictions

LightBurn will need to maintain a constant connection with the
external license server to verify licenses. If you are experiencing
difficulties with a license not being verified, your network may be
restricting LightBurn's access.

To ensure LightBurn can contact the license server, whitelist
api.cryptlex.com for port 443.

It is also possible to configure LightBurn to access the network
through a proxy. You can append the proxy connection address
using -p ProxyString.

The proxy format is:

Examples of valid proxy strings:

1. 

2. 

a. 

b. 

3. 

CD “c:\program files\LightBurn”

4. 

LightBurn -l (license key code here)

Note

1. 

2. 

a. 

b. 

3. 

cd /Applications/LightBurn.app/Contents/MacOS

sudo ./LightBurn -l (license key code here)

Note

Tip

[protocol://][username:password@]machine[:port]

http://127.0.0.1:8000/
http://user:pass@127.0.0.1:8000/
socks5://127.0.0.1:8000/

2.4 System Locked and Floating License Setup
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2.4.3 Troubleshooting

The most common error we see in this process is not running an
admin command shell — if you just run it in user mode, it doesn't
have permission to create a file in the Program Files folder.

On Windows, make sure to right-click and select Run as
administrator when opening the Command Prompt app.

On MacOS, make sure to include sudo when entering the
command to activate the key.

The second most common error we see is mis-entering the
license key or command prompt entries. Our instructions show
the command line like this:

That is "LightBurn", followed by a minus sign and a lower-case
letter L, a space, then your license key (without the parentheses
around it).

Here is an example entry using a fake key:

• 

• 

LightBurn -l (license key code here)

LightBurn -l ABCDEF-123456-789012-FDBEA1-2G675A

2.4.3 Troubleshooting
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safety

3. Disclaimer and Safety

 WARNING

LASERS USE INTENSE BEAMS OF LIGHT, INCLUDING LIGHT THAT MAY NOT BE VISIBLE.

IMPROPER USE OF LIGHTBURN SOFTWARE WITH ANY DEVICE MAY BE DANGEROUS AND COULD RESULT IN PERSONAL INJURY, DEATH, OR
PROPERTY DAMAGE. ALWAYS FOLLOW THE DEVICE MANUFACTURER'S INSTRUCTIONS AND GUIDELINES.

ALWAYS WEAR PROPER EYE PROTECTION WHEN USING YOUR LASER.

 WARNING

DO NOT LEAVE A LASER UNATTENDED WHILE IN OPERATION.

3. Disclaimer and Safety
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Troubleshooting

4. Troubleshooting

If you're having trouble using LightBurn, our troubleshooting resources are a great place to start looking for help with common problems
and frequenly asked questions. You can also email support, and talk with LightBurn staff and users on our forum. 

Over time, we will be adding more troubleshooting resources. We'll try to keep links consistent, but if a link to a specific troubleshooting
resource changes, you'll always be able to find it from this page. If you can't find what you're looking for, you can contact our documentation
team by clicking the envelope icon next to any header and let us know.

4.1 What's Wrong?

Choose a category below for more help.

Connection Problems

Get help connecting your laser to a computer and sending jobs to it.

Job Quality

Resources to help you figure out why your laser's output doesn't look how you expect.

LightBurn Editor FAQ

Frequently asked questions about creating and editing designs in LightBurn.

GRBL Errors

Resources to help you understand GRBL-specific errors.

License Activation and Management

Solutions to common License Activation and Management issues.

4. Troubleshooting

- 19/44 - ©️ LightBurn Software, LLC

mailto:support@lightburnsoftware.com
https://forum.lightburnsoftware.com/


5. Beginner Docs

Beginner Docs First Steps

5.1 What Is LightBurn?

LightBurn is a layout, editing, and control software for your laser cutter. LightBurn talks directly to your laser without the use of additional
software. 

With LightBurn you can:

Import artwork in a variety of common vector graphic and image formats (including AI, PDF, SVG, DXF, PLT, PNG, JPG, GIF, and BMP)

Arrange, edit, and even create new vector shapes within the editor, with powerful features like offsetting, boolean operations, welding,
and node editing

Apply settings like power, speed, number of passes, cut order, brightness & contrast, dithering mode, and much more

Send the result directly to your laser cutter

LightBurn is a native application written for Windows, macOS, and Linux.

• 

• 

• 

• 

5. Beginner Docs
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5.2 Beginner Walkthrough

Beginner Docs First Steps

5.2.1 Adding & Configuring for Beginners

LightBurn can't control every laser, but it can talk to a number of
different types of laser controllers, all of which use different ways
of communicating, and have different abilities and settings.

This step tells LightBurn what type of laser you have.

If you've never configured a device in LightBurn, you'll be
brought here automatically when you run the software. It is
important that you pick something because the interface in
LightBurn will change depending on the capabilities of the laser
you choose. If you don't have a laser to connect to yet, you can 
create a placeholder device.

If you've done this before but want to change your laser or add a
new one, click the Devices button in the Laser Window to bring
up the devices list.

LightBurn can also be configured to control more than one laser,
and there are settings stored for each device. If you don't pick
one, we have nowhere to put these settings, and a number of
features within LightBurn will not work until this is set up.

The Devices Window

This is the Devices window in LightBurn. Here you will see a list of
all the laser devices you've added to LightBurn, or an empty list
when you're first starting.

The simplest way to proceed is to click Find My Laser and let
LightBurn locate and identify your laser. If that doesn't work,
your laser may connect with Ethernet, or if you have a Marlin
device, you'll need to use Create Manually. If you're using a
LightBurn Bridge device, you can use the LightBurn Bridge setup.

Find My Laser

Create Manually

LightBurn Bridge

You can also import and export laser configurations to move
them between computers using the Export button on this page
from the source computer and then import it to the new install
using the Import button. Exporting will create a .lbdev
(LightBurn device) file which contains all of the device specific
information LightBurn needs to import that machine's profile
into the new computer.

You can import a LightBurn Device profile by dragging and
dropping it into the LightBurn window.

• 

• 

• 

Tip

5.2 Beginner Walkthrough
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What if I don't have a laser yet?

You don't ever need to connect a laser to LightBurn to use it, but
LightBurn will not run without a device profile configured,
because it needs a place to store some settings, and wants to
know what options to show you in the interface. If you use a laser
that accepts files on a USB drive for example, LightBurn needs to
know which controller it uses so it can produce the correct
output files.

To start using LightBurn without a laser, use Create Manually and
configure the things you can, and guess at whatever you don't
know. When you finally do get your laser, you can come back to
this screen, select the 'dummy' profile you set up, and click 
Remove . Then you can follow the setup steps here for real this
time and use your laser!

Configuring

If you have a GCode controller—particularly if you also use your
system as a CNC or 3D printer—there may be additional
configuration required.

Common GRBL setups

If you have a Ruida DSP controller and are configuring from
scratch, read here:

Configuring a Ruida

If you're using a galvo laser, start here:

Configuring A Galvo

• 

• 

• 

5.2.1 Adding & Configuring for Beginners
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5.2.2 Coordinates and Job Origin

There are a few ways to tell LightBurn where to ouput your
project within the work area of your machine, each available in
the Start From menu in the Laser window. 

Absolute Coordinates

Absolute Coordinates is the simplest option. The grid you see in
the main editing window of LightBurn represents your machine's
physical work area. Anything you place in the LightBurn grid will
be output in the corresponding location in your machine's work
area.

Using absolute positioning requires a laser with homing
switches and a fixed origin. If you have a small diode laser that
does not have homing switches, you will need to manually home
the machine. See: Machines without homing sensors / limit
switches.

In the image below, the two circles placed in the middle of the
LightBurn grid will be cut in the middle of the machine work
area. The green square in the lower left of the image represents
the Job Origin, and the red square in the same place shows the 
Machine Origin. When using Absolute Coordinates these are
always in the same place.

Current Position

With Current Position selected, your job outputs relative to the
current position of the laser head when you hit the Start button.
The Job Origin control in the Laser window tells LightBurn how
to orient output relative to the laser head.

In this image, we're starting from the Current Position, with the
Job Origin set to the lower left:

Notice that the green Job Origin indicator has moved. This
represents the position of the laser when you start the job, so the
laser is going to move slightly up and to the right from wherever
it is, cut the two circles, and go back to where it started.

Now imagine that you want to etch this two-circle pattern onto a
coaster or a phone case. Lining it up from the lower left is not
easy. If you change the Job Origin setting to center, you get this
instead:

The job will be centered around the current position of the laser
head. If you position the laser head directly over the center of the
item you want to etch, the output will be centered on the item.

User Origin

User Origin works almost exactly the same as Current Position,
except that the starting location is programmable. To set a User
Origin, you must first jog your laser to the location you want your
job to start from, then set the origin. 

Note
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Some lasers with digital displays, such as those with Ruida
controllers, have an Origin  button which you press to set the
origin. GCode-based systems use the Set Origin button in the 
Move window in LightBurn to do the same thing. 

After setting the origin, you are free to move your laser around
the workspace. With User Origin selected as the Start From
mode, the laser will move back to that programmed location and
start the project from there.

As with Current Position, the Job Origin setting determines how
output will be oriented relative the user-defined origin. 

Finish Position

The Finish Position option is only available for GCode-based
controllers. DSP controllers manage this internally.

LightBurn allows you to control where you want the head of the
laser to return after a job is finished. By default, it will return to
0,0, but this is not always optimal for all machines. 

To change your laser's Finish Position, go to the Move window
and use the arrows to position your laser head wherever you
would like it to return to after the job is finished, then click the 
Set Finish Position button. Your machine will now remember
that spot for future jobs. Finish Position can be adjusted at any
time by repeating the above steps for a new location.

Using Finish Position requires that the job is running in 
Absolute Coords or User Origin mode. Finish position does not
work when using Current Position.

Users with GCode-based lasers can also adjust or disable the
Finish Position in the Device Settings window. 

Note
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5.2.3 Basic Usage: The Essentials

So far we've done a brief introduction to the UI and covered 
zooming, panning, and selecting.

The next things we'll cover are:

Creating Shapes

Importing Artwork

Moving and Sizing Artwork

Grouping

Cut Layer Settings

Controlling the Laser

Creating Shapes

LightBurn's shape creation tools let you create simple shapes.
Choose a tool from the left toolbar, like the ellipse, rectangle, or
polygon tools. With a tool selected, left-click in the workspace
and drag the mouse to adjust the size of the shape you're
creating. While dragging, the Shift key will force the shape to
have the same width and height, so you get circles and squares
instead of ellipses and rectangles. The Ctrl key causes the shape
to be centered on the starting point, instead of dragging it out
from corner to corner. Release the mouse button to finalize the
shape.

For text, select the text tool, then click in the edit window to place
the cursor. Type your text, and press the Esc key when finished.

Importing Artwork

The shape creation tools let you make simple shapes in
LightBurn, like circles, rectangles, text, and polygons, and also
give you the ability to edit and adjust them, but LightBurn isn't
intended to be a complete artist package or dimensioned
modeling tool. For that, you would use external software like
CorelDraw, Adobe Illustrator, Inkscape, or AutoCAD. Photo or
image manipulation software such as Photoshop or GIMP can be
used to create or manipulate image files.

When you have artwork ready in one of these programs, the next
step is to import it into LightBurn to adjust the settings.
LightBurn can import the following file types:

Vector / mixed formats:

.ai - Adobe Illustrator

.svg - Scalable Vector Graphics

.dxf - AutoCAD Drawing Exchange Format

.pdf - Adobe Portable Document Format

.plt / .hpgl - Plotter / Hewlett-Packard Graphics Language

Image formats:

.png - Portable Network Graphics

.jpg / .jpeg - Joint Photographic Experts Group format

.bmp - Windows Bitmap

.gif - Graphics Interchange Format

.tif / .tiff - Tagged Image File Format

Note that not all features of every format will be supported.
Vector graphics formats in particular are incredibly complex, and
using more advanced features, like pattern fills, masking,
gradients, and so on will not necessarily translate well when
importing. LightBurn cares about shape outlines - if you want
artwork to include the advanced features, the best option is
usually exporting as a high-DPI image.

You can import files into LightBurn in several different ways:

Clicking the Import button on the main toolbar ( )

Using the File > Import option from the main menu

Pressing the Import keyboard shortcut (Ctrl + I)

Dragging a file from the Windows Explorer or MacOS Finder
into LightBurn

Copying and Pasting an image from a browser window into
LightBurn

Moving and Sizing Artwork

Once you have your artwork in LightBurn, the next step is usually
placing or sizing it. When one or more items are selected, you'll
see various "tool handles" appear around the outside of the
selection, like this:

In the image above, you can see 9 gray squares, and four arrows.
If you hover your mouse over any of them, the cursor will change
to indicate the kind of operation that tool performs - resizing,
moving, or rotating.

Grabbing any of the four corners will let you resize the artwork
from that corner, and defaults to uniform resizing with the
opposite corner as the anchor point. Holding the Ctrl key (or
Command on Mac) switches the anchor point to the center, so
the object center remains in place when resizing. Holding the
Shift key allows you to resize the width and height independently,
instead of locking them together.

Grabbing any of the four side handles will let you adjust the
width or height of the selection, and the Ctrl (or Command) key
switches to center anchor just as it does with corner sizing. When
moving, the status bar shows both the absolute position of the
selection being moved, and the relative distance it has moved.

The center handle is for moving the selection, though you can
also click and drag any edge of any shape to do this as well.
When moving a selection, holding the Shift key constrains the
movement to be horizontal, vertical, or diagonal.

The four rotate handles allow you to rotate the object freely
using the mouse. While rotating, the relative rotation is displayed
in the status bar. Holding the Ctrl key (Command on Mac) snaps
the rotation to the nearest 5 degrees, holding Shift will snap to
15 degrees, and holding Ctrl+Shift snaps to 45 degrees.
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You can also move, rotate, and resize artwork using the Numeric
Edits Toolbar.

Grouping

When you create shapes in LightBurn, they're independent of
other shapes you create. Sometimes it's handy to be able to treat
a collection of things as a single unit, to make sure they keep
their relative position and size when you're moving them around.
In LightBurn, this is called a Group. If you select two or more

shapes and click the 'Group' button ( ), or press Ctrl

+ G , you'll create a new object that contains the original
shapes. To un-group the objects so you can edit the individual
parts, select a group of shapes and click the un-group button

( ), or Ctrl + U .

You can tell if a shape is in a group or not based on how it looks
when selected.

Ungrouped objects are displayed with a simple dash pattern
when selected, like the single circle above on the left. A grouped
shape shows a repeating dot-dot-dash pattern when selected,
shown on the three smaller circles above on the right.

Cut Layer Settings

Artwork imported from vector files assigns shapes to layers in
LightBurn based on the colors of the vectors in the original file. If
you create your files with this in mind, it can save you time.

Layers in LightBurn are used to assign different settings to the
shapes in your design. For example:

In the above design, black could be used for a solid, dark
engraving, blue could be a very light engraving with an outline to
add definition to the text, and red would be a slow, high-power
cutting layer. The final output to the laser might look like this:

The information shown in the Cuts / Layers window is just the
basics. You can see the full set of options for a layer by double-
clicking the entry in the layer list to bring up the Cut Settings
window.

Controlling the Laser

There are two windows primarily used to control the laser:

The Laser Window, shown in the lower right of the display by
default, lets you select your laser, start, stop, or pause a job,
frame the design (move the laser head around the boundary of
your design to test alignment), and more. These options can vary
based on the type of laser you're using.

The Move Window, docked behind the Cuts / Layers window by
default, gives you jog buttons and positioning control, and the
'Speed' value there is used when framing or jogging the laser in
LightBurn.

⌃

⌃
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There are a couple other methods for moving the laser that are
noteworthy:

The Click-to-Position tool ( ) on the Creation Tools toolbar
lets you click anywhere in the workspace and LightBurn will
jog the laser to that point.

Note that this assumes that your laser has been properly
homed - Some DIY-style machines do not have homing

switches, so using any form of absolute positioning in
LightBurn requires extra steps.

The number pad arrow keys can be used to jog the laser after
clicking in the edit window (workspace).

The Arrange menu and arrangement tools can be used to
move the laser relative to artwork in the workspace.

• 

• 

• 

• 
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5.2.4 Making a Simple Project

We're going to go step-by-step through creating a small, simple
project in LightBurn, from start to finish, to show you how to use
a few of the basic editing tools, and give you a feel for how things
work.

Before you start, make sure you have a laser set up in LightBurn
(see Adding your Laser).

This project will be a simple name tag, cut out around the letters,
ideally made from thin wood or acrylic, but a piece of cardboard
will do.

Creating the text

With LightBurn running, and an empty project, click the Create
Text button shown below. It normally lives along the left side of
the main window:

Next, click the mouse somewhere in the middle of the Edit
window (the workspace) to get a cursor, then type your name:

Click the 'Select' tool button on the top left of the edit window, or
press Esc  twice (once to finish entering text, and again to exit
text entry and go back to selection mode).

When you finish the text, you'll see an entry appear in the Cuts /
Layers list on the upper right of the display. This is the "layer"
that your text is on, and it holds the settings that will be sent to
the laser for all the objects on this layer:

This tells us that the shapes on this layer will be drawn as lines,
with 100 mm/sec speed, and 20% power. Depending on your
settings, the '100.0' might be different - Diode lasers are less
powerful than CO2 lasers, and run slower, so they tend to use
mm/minute as units, so the same default value would display as
6000 mm/min. If you have your units set to Inches, you might
see 3.9 in/sec, or 236 in/min.

Previewing

To see how the laser will run your project, click the Preview
button in the middle of the main toolbar:

The preview window will pop up, showing the completed job, like
this:

The lighter red lines are showing the laser moving between the
shapes (traversal moves), and the black lines are where the laser
will burn. Click the 'Play' button and you can watch a simulation
of how the laser will run the job. You can also grab the slider and
drag it around to see the cut at different points in time. Spot
checking the output like this is a good habit to get into, because
you'll likely spot mistakes before you burn the project for real,
saving time and material. Click the 'Ok' button to close the
preview.

For more information on the preview window see its page here 
Preview Window

⎋
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Changing text properties

Make sure you're still in Selection mode - the 'Select' tool should
be highlighted. Click the name, or click and drag a rectangle
around it to select it. When it's selected, it will be drawn as
animated dashes instead of solid lines, and handles will appear
around the selection to let you change the size, position, or
orientation.

The options in the Text Toolbar at the top will activate, like this:

Click the drop down for the font, and change it to anything you
like. While you are choosing, the changes will be displayed in real
time in the edit window. You can change the height, make it bold
or italic, and adjust spacing here too.

Undo / Redo

If you make a change you don't like, you can undo it by clicking
the Undo button on the toolbar (or pressing Ctrl + Z , or Edit
> Undo in the menu). If you decide you liked it after all, you can
also Redo ( Ctrl + Shift + Z  / Cmd + Shift + Z ).
Undo and Redo in LightBurn are unlimited - the undo system
doesn't reset unless you create a new file or close the program.

Changing the Layer settings

Rather than outline the text, we're going to change it to be solid
filled. In the Cuts / Layers window, click where it says 'Line' and
change it to 'Fill', like this:

You'll notice that the display in the edit window hasn't changed,
but if you run the preview again, it looks quite different. By
default, the view in LightBurn shows outlines only, not fills,
because it's much faster, and it prevents things from being
hidden behind solid shapes that might still be run on the laser.

Adding an outline: The Offset tool

With the text selected, click the 'Offset' button on the left toolbar,
shown here:

The Offset options window will appear, and you should see
something like this:

The offset tool creates a new shape by outlining the shapes in
your selection at a given distance, either inward, outward, or
both, and merging the result. If you point the mouse at the
'Offset Distance' value, you can scroll the mouse wheel to change
the number and watch the result change on the fly. You can also
click the box and just enter a number as well.

Make the Offset Distance value large enough that there are no
internal gaps in the outline - Notice the gap above between the L
and the next letter is gone in the version below:

When you're happy with the result, click 'OK'.

Changing Layers

Now, use the left mouse button to click the new outline you just
made, so it is the only thing selected, like this:

Then, click the Red button in the color palette at the bottom of
the display:

⌃

⌃ ⇧ ⌘ ⇧
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The outline will turn red, and you should see two entries in your
Cuts / Layers list, like this:

The first, the black layer, is the fill for your text, and the second
red layer is for the outline cut.

Speed and Power

This is where things get a little tricky in terms of you being able
to follow along. Speed and power settings vary quite a bit
between lasers, and LightBurn supports a lot of different types of
machines. It also depends on the kind of material you're using -
cutting through ⅛" basswood uses much less power than cutting
through ¼" plywood or acrylic. For right now we'll assume ⅛" (3
mm) plywood and give some guesses for settings, but you'll
probably have to change them.

To start with, click the black color entry in the Cuts / Layers
window. Below the list of layers you'll see the Cut Info window,
containing something like this:

For the text, you want enough power to engrave into the
material you're using, but not too deep.

If you have a CO2 laser, use 200 mm/sec, 15% power (both
Power Min and Power Max - more on this later) and leave
everything else.

If you have a diode laser, use 50 mm/sec (or 3000 mm/min),
and 50% power.

Understand that this is a rough starting point, and you will
probably need to change this later.

Now, click the red entry in the Cuts / Layers window. This is going
to be what cuts through the material to cut out the shape.
Cutting requires more power and much less speed.

For a CO2 laser, set 15 mm/sec, 75% power (again for both min
and max power)

For a diode laser, use 2 mm/sec (120 mm/min), and 100%
power. Depending on the strength of the diode you have, you

might need to go slower than this, or use more passes by
setting the Pass Count value higher.

Again, these are guesses, but they're a starting point.

Open the Preview window again (Alt+P, or click the Preview
button), then drag the progress slider from left to right to watch
how the job will run. You'll see the text engrave first, followed by
the outline cut. If you don't see those things, check the settings
again, and verify that you have the first layer (black) set to Fill,
and the second layer (red) set to Line.

Positioning the Job on the Laser

When sending this to the laser, there are a couple of different
ways that it can be positioned, and the one you choose may
depend on the kind of hardware you have. If you have a small
diode laser that does not having homing switches, you will likely
want to run the job using the 'Current Position' mode. For now,
that's what we'll recommend for everyone, since it's easy.

If you have an Ortur Laser Master, or other small laser that does
have homing switches enabled, you will likely find 'Absolute
Coords' to be the simpler setting to use - this means that
wherever you place your work in LightBurn is exactly where it will
go on the laser.

In the Laser window, which is in the lower-right of the main
window by default, look for the 'Start From' drop down box, and
choose 'Current Position' or 'Absolute Coords'. If you see
'Controller Setting' in this window, it means you have a Trocen
Controller, and the start position is set from the controller
menus, not from software. Don't sweat it for now.

If you used 'Current Position' mode, you'll see the 9-dot "Job
Origin" control under it activate, and you should see a green
square on your design in the same spot indicated by Job Origin
control, like this:

In the above image, the Job Origin is set to the lower-left, and
that's where the green origin square is on the design. That green
square represents the position of the laser before you start the
job, so the design is going to end up above and to the right of
wherever the laser is when we press Start.

Put a piece of material in the bed of the laser, and use the arrow
keys on the laser controller (if you have that) to move the head of

• 

• 

• 

• 
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the laser to the lower-left corner of the material. If your laser
controller doesn't have arrows, click an empty spot in the edit
window, then use the arrows on the Number Pad of your
keyboard to jog the laser around instead.

When you think it's lined up, press the button labeled 'Frame'.
The head of the laser will move in a rectangle around where the
job will go. If you need to adjust anything, do so, then Frame
again.

If you only have the option for 'Controller Setting' in the above
window, when you position the laser in the lower corner of the
material, press the button labeled 'Origin' on the controller panel
to tell the controller this is where you'd like the job to start.

When everything is lined up, close the lid on the laser (or if you
don't have one, put on your safety glasses), then press the Start
button.

If anything goes wrong, hit the Stop button to abort the job, but
if not, let it finish. When it completes, have a look at how things
ended up - if the engraving of the name is too deep or too dark,
you can increase the speed or reduce the power (or both). If the
cut didn't go all the way through, reduce the speed or increase
the power (or both). If you don't move your part, you can run the
cut again (possibly with new settings) without having to use a
new piece of material..

Results and Next Steps

When it's done, hopefully it looks like something like this:

That's it for this quick tutorial - It's only meant to be a starting
point, but hopefully it was enough to give you a little foundation,
and a taste of how things work.

Next Steps:

We recommend going through some of our "LightBurn Basics"
tutorials on YouTube, and we have a great project tutorial that's a
little more in depth called the "WIFI QR Code tutorial" that covers
more ground, including importing.

LightBurn YouTube channel• 
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5.3 LightBurn UI Tour

If you've never used LightBurn before, the main window might seem a little intimidating. Try not to let it scare you - we'll break out the
important sections to start with. LightBurn also has some features to make it easier to learn:

Tool tips: If you hover the mouse over a control, you'll see a small bit of text pop up that describes that button or feature, like this:

If you hover the mouse over something and press the F1  key (help), LightBurn will launch the help page for that feature in your browser. Most
of the panels and buttons on the main window of LightBurn will do this.

5.3.1 The Main Window

This is the default layout for the main LightBurn window:

Here it is again, with the sections labeled:

Open Image 

It's worth noting that along the very bottom of the main display
is a status bar that will occasionally show information like an
automatic backup in progress, position of the cursor, laser
connecting, and so on.

The main sections of the user interface are all linked as chapters,
so you can skip around as needed. It's a big application but you
don't need to know all of it to use it well!

The Main Window

Menus

Main Toolbar

Creation & Modifier Tools

Color Palette

Tool Layers

Cuts & Layers

Size, Position, Numeric Edits

Font & Text

• 

Help
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Laser Window

Workspace / Edit Window

For a full list of the windows and dockables in LightBurn, see the 
section on the user interface.

These are the windows you will use most commonly, though
there are others. If you ever close one accidentally and want it
back, go to the menu bar, click the Window  menu, or just right-click
an empty space on the toolbar, and re-enable the window you
want back.

5.3.2 Menus

Almost all desktop software uses menus in some form. The menu
bar at the top of the main window gives you access to almost
every feature available in LightBurn.

Depending on the operating system you're using the menus
might appear a little differently, and some features may be
removed if your laser doesn't support them.

If a feature has a shortcut, it will be shown next to it in the menu,
as shown above. Learning the shortcuts for the features you use
most often will make using LightBurn much faster, and

sometimes there are even 'shorter' shortcuts - you can find these
in the help menu under Help > Quick Help and Notes.

See Menus for detailed information.

5.3.3 Main Toolbar

The main toolbar in LightBurn gives you quick access to
commonly used functions for opening or importing files, saving,
using the clipboard (copy & paste), moving or zooming the view.
Right beside it is the Arrangement toolbar, containing some
commonly used arrangement tools for arranging and aligning
shapes.

If you aren't sure what a button is for, hover the mouse over it
and it will tell you:

See Main Toolbar and Arrangement Toolbar for detailed
information.

5.3.4 Creation & Modifier Tools

The shape creation tools are normally arranged vertically, but
we're showing them sideways here. By default, these are docked
along the left side of the work space for quick access.

The first tool, 'Select' is probably the one you'll use most, and is
the default tool chosen when LightBurn starts. The others are
used to create basic shapes like circles and rectangles, text, and
lines, and there are few for modifying shapes in more
complicated ways, like merging shapes, or creating lots of copies
of shapes.

See Creation Tool and Modifier Tool for detailed information.

5.3.5 Color Palette

The color palette lives along the bottom of the main window by
default, though a common alternative is docking it next to the
creation tools along the left.

Lasers don't print in color, so these colors are used to assign
different kinds of operations to the shapes in your design. A
common convention is to use bright red for cuts, though how
you use the colors is up to you.

With nothing selected in the workspace, click a color entry and
subsequent new shapes will be created in that color. If you have
something selected, clicking a color entry will apply that color to
the shapes in your selection. The colors currently in use in your
design will also appear as entries in the Cuts / Layers window,
where you can choose the operations that each color will
represent.

5.3.2 Menus
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See Layer Colors for detailed information.

Tool Layers

There are two special layers at the end of the cut palette, labeled 
T1 and T2. These are Tool Layers and are used for creating non-
output shapes in your designs. These layers have no cut
parameters and will never be output to the laser. For example
you could use them for:

Indicating pre-determined material size and position on your
machine

Guide-lines for aligning shapes

Apply Path to Text (without the path being output)

Image Masking

5.3.6 Cuts / Layers

The Cuts / Layers window shows the colors currently in use in
your design, and lets you quickly access the settings assigned to
each color.

The first column shows the name you've assigned to this layer,
followed by the color, then the Mode (Line, Fill, both, or Image).
Then the speed and power are displayed, followed by the options
to enable or disable sending this layer to the laser, or displaying
it in the workspace.

Underneath the layer list you can see and change the basic
settings for the currently selected layer. Double-clicking an entry
in the layer list, it will bring up a larger Cut Settings Editor with
a more complete set of options.

See Cuts / Layers Window for detailed information.

5.3.7 Size and Position / Numeric Edits

The Numeric Edits toolbar lets you resize, position, and rotate
shapes, and change the unit of measure.

The Lock button can be used to maintain the aspect ratio of your
objects when changing the size, and the 9-dot control lets you
choose the positioning and sizing origin point. The number entry
boxes accept equations and units as well--e.g. entering 5 mm,
5in, 5", or 5 * 3 mm will be processed into the correct result.

See Numeric Edits Toolbar for detailed information.

5.3.8 Fonts and Text Controls

The font and text toolbar will activate when the Create Text tool
is used or when text objects are selected.

This toolbar lets you change the font, size, spacing, alignment,
and automatic character welding settings. The Fonts and Text
toolbar also includes settings for variable text, e.g. serial
numbers, dates, and data tables read from CSV files.

See Fonts and Text for detailed information.

5.3.9 Laser Window

The Laser Window is used to select the active machine, test the
framing (the artwork's outer bounds), run and stop the machine,
and choose the file processing, order, and artwork positioning
within the workspace.

Note that this window may look different for you depending on
the type of laser chosen and the options it supports, and some
options will be hidden if you are in 'Beginner Mode'.

See Laser Window for detailed information.

• 

• 

• 

• 
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5.3.10 Workspace / Edit Window

The workspace, or edit window, is the drawing area where your
design is laid out. The size of the border and grid within the

workspace represents the available work area on your machine.
The artwork arranged and displayed within the workspace will be
processed and sent to your machine for production.

Next Step: Zooming, Panning, and Selection

5.3.10 Workspace / Edit Window
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5.4 Feature Comparison

Feature LightBurn RDWorks LaserCAD AutoLaser LaserWeb

Windows 7, 8,
10

* * * * *

Mac OSX * *

Linux * *

64-bit native
application

*

Drag & Drop *

Copy & Paste
with system
clipboard

*

Undo / Redo Unlimited 20 steps Unlimited 30 steps no

User support
forum

*

CorelDraw
macro

* * * *

Rectangular
array tool

* * * *

Circular array
tool

*

Illustrator
import (AI)

* * * *

PDF import * *

SVG Import * * *

DXF import * * * * *

Support for DXF
instances

*

Specify cut start
point &
direction

* * * *

Mixed manual /
automatic cut
order

*

Automatic
Inside / outside
cut order

* * * *

Ruida controller
support

* *

Trocen
controller
support

* *

TopWisdom
controller
support

* *

* *

5.4 Feature Comparison
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Feature LightBurn RDWorks LaserCAD AutoLaser LaserWeb

GCode
controller
support

Integrated
webcam
support for job
placement

*

Print & Cut
registration
mark support

* * (requires RDV
controller)

Image
operations

Image dither
modes

7 2 0 2 0

Halftone image
generation

* * *

Transparent
bitmap support

*

Brightness /
Contrast image
controls

* * * *

Image edge
enhancement

*

Vectorize image
(trace)

* * *

Crop / Mask
images

*

Vector
Operations

Create and edit
vector graphics
in-app

* * * *

Vector shape
node-level
editing

* * * *

Automatic text
welding

*

Boolean
operations
(union, subtract,
weld)

*

Shape offsetting * * (poor) * (poor) * (poor)

Welded offsets *

Multiple offset
corner types
(round / sharp /
beveled)

*

Use objects as
guides

*

Create
rectangles with

*

5.4 Feature Comparison
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Feature LightBurn RDWorks LaserCAD AutoLaser LaserWeb

rounded
corners

Fillet shape
corners

*

Multiple object
selection modes
(crossing,
enclosing)

*

Fully simulated
preview

* *

Text / Font
Operations

TrueType font
support

* * * *

SHX font
support

* * * *

Apply text to
curved path

*

Bend text *

Engraving
operations

Ramp
generation (for
stamp making)

* * * *

Material
Settings Library

* *

Rotary
engraving
support

* * * * *

Tool path
preview

* * * * *

Move laser to
graphic position

*

Move graphic to
laser position

*

Jog laser by
clicking in page

*

Jog laser with
numeric keypad

* *

5.4 Feature Comparison
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6. Primary Docs

6.1 Tips and Tricks

LightBurn has a decent number of user interface tricks that aren't always obvious, so we're listing many of them here. We also have a 
LightBurn HotKey reference guide here.

6.1.1 Tool Tips

Nearly everything in LightBurn has pop-up text that will tell you
what the control is for and sometimes gives additional help, like
this:

6.1.2 Topic-Aware Help

If you point the mouse cursor at a button or window and press 
F1  (help), LightBurn will launch your browser and open the

documentation on the relevant help page for that control. This
works for nearly all controls on the main window.

6.1.3 Reset the Window Layout

Sometimes a window gets moved off the screen or positioned in
a way that makes it hard to find or move. You can reset the
window layout in LightBurn in two different ways:

In the Window menu, choose "Reset to default layout". This
will undock all windows, and re-dock them in the default order.

If that doesn't do it, restart LightBurn while holding Shift  -
this skips restoring the saved window layout, and always
works.

6.1.4 Reset to Default Settings

To completely reset LightBurn's settings:

Open LightBurn

Go to File → Open Prefs Folder

Close LightBurn

Delete the contents of the prefs folder, which should contain a pair
of files called prefs.ini  and prefs.old

Re-open LightBurn. All settings should be reset to default, and all
devices will be removed.

6.1.5 Edit Window Shortcuts

The edit window has a number of single-key shortcuts that are
only active when you have clicked in the edit window. They are:

H  — flip selection horizontally

V  — flip selection vertically

L , R , T , B  — Align the selected objects by Left, Right,
Top, or Bottom edges

C  — Align the selected objects along their vertical
centerlines

E  — Align the selected objects along their horizontal
centerlines

P  — Move the selection to the center of the page

Arrow keys — Move the selection ( Shift  and Ctrl  adjust
the size of the move)

,  (comma) and .  (decimal), usually under <  and 1 , are
rotated 90° counterclockwise and clockwise

Holding Shift while pressing ,  (comma) and .  (period/
decimal) will rotate 45°

Tab  — Select the next shape in the shape list

Number pad arrows — Jog the laser

6.1.6 Framing Mode Nudging

While framing, the keyboard can be used to make minor
adjustments to your graphics. Use the arrow keys to move your
graphics 1 mm at a time. For additional nudge options, please
see Framing.

6.1.7 Equation Support in Number Boxes

The position, width, and height boxes in LightBurn will accept not
just numbers, but also measurements and equations. All of these
are valid:

50 mm, 5 cm

10 in, 10"

2 ft, 2'

10.25 / 2

(10+2) * 4 + 1 in

You can also use the constants e and pi, and functions like sin,
cos, tan, sqrt, abs, atan, log, pow, and more.

6.1.8 Copy & Paste from Other Applications

LightBurn can paste data in known formats from other
applications.

An image copied from a browser can be pasted into LightBurn

Text copied from anywhere can be pasted into LightBurn

Shapes copied from Inkscape can be pasted into LightBurn

6.1.9 Drag & Drop from the File Browser

Files in any format supported by LightBurn can be dragged into
LightBurn from your file browser (Windows file explorer, or
Finder on macOS).

• 

• ⇧

1. 

2. 

3. 

4. 

5. 

• 

• 

• 

• 

• 

• 

• ⇧ ⌃

• 

• 

• ⇥

• 

• 

• 

• 

• 

• 

• 

• 

• 
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6.1.10 Automatic File Backups

LightBurn by default will save backups of whatever file you are
working on. If you have previously saved the file as a LightBurn
project, the backup will be stored in the same folder, with the
same name, but with "_backup" appended to it.

If you haven't saved the file with a name yet, LightBurn will store
the backups for it in you Documents folder with the name
"AutoSave_xxxx" where the x's are a random string of characters.
If LightBurn crashes, you can usually open the most recent of
these files to recover your work.

6.1.11 Auto-Start a Job on Send

Hold the Shift  key when you click the Send button in
LightBurn, and LightBurn will automatically run the file on the
laser when the transfer is completed. This is useful if you are
sending very complex or large files, and want to be certain that
the transfer completes before the job starts running, but saves
you from having to press Start on the controller.

6.1.12 Pause and Stop from the Keyboard

While your laser is running, you can use your keyboard's Pause

key to pause the laser and Ctrl + Break  to stop it. Break  is
typically on the same key as Pause , but more compact keyboards
may not have this key.

6.1.13 Setting up a New Computer

Setting up a new computer can be a pain—especially if you've
put a lot of time and effort into adding machines and configuring
your LightBurn installation exactly how you like it. To avoid
repeating all that work, you can export your preferences on your
old computer using File → Export Prefs, and then import them
on your new computer using File → Import Prefs. Starting in
version 1.3, there is also an Import Prefs button in the Devices
window if no lasers have been added—this lets you import
preference files when you first open a fresh installation of
LightBurn.

6.1.14 Alignment Guides

LightBurn 1.5 and higher

Click here for a video overview

While dragging to draw, move, or scale objects, holding Alt

will produce alignment guides for edges and midpoints of
existing objects.

Using Alignment Guides by holding down Alt  while drawing

6.1.15 Draggable Guidelines

LightBurn 1.5 and higher

Click here for a video overview

Horizontal and vertical guidelines can now be created by
dragging from the ruler area of the LightBurn workspace.
Guidelines can be treated like any other line. Guidelines can be
locked to avoid accidentally moving them.

You can also make guidelines of any shape by drawing objects and
adding them to one of the Tool Layers

⇧

⌃

⎇

⎇
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6.2 Installation & Licensing

Beginner Docs Installation

Installation & Setup

COMPUTER REQUIREMENTS

Current versions of LightBurn run on the following operating systems:

64-bit Windows 7.0 or later

macOS 10.13 or later

64-bit Ubuntu Linux 20.04 or later

LightBurn does not require a powerful computer for most work, although more memory is helpful for designs with a lot of images. As with
most things, a faster computer will make it easier to work with large images or complex graphics.

Previous versions of LightBurn going back to version 0.6 are archived on our website.

macOS users running versions older than 10.13 should download LightBurn 1.6.03, which supports macOS 10.11 or newer.

Users limited to 32-bit versions of Windows should download LightBurn 1.5.06, which is the final 32-bit release of LightBurn.

Ubuntu 18.04 users unable to upgrade to a more recent operating system should download LightBurn 1.2.01, which is the last release
compatible with Ubuntu 18.04.

LightBurn 1.7 will be the final LightBurn version available for Linux. 

DOWNLOAD LIGHTBURN

To ensure you get the most recent version of LightBurn, download LightBurn directly from the Download / Trial page at 
lightburnsoftware.com. On this page, you'll find links to download the current version of LightBurn, as well as links to previous versions of
the software and public beta versions. 

When you've completed the download, you should see the file in your "Downloads" folder or a manually selected folder.

• 

• 

• 

Support for older operating systems

• 

• 

• 

• 
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INSTALLATION DIRECTIONS

Choose your operating system below for additional installation help. 

6.2 Installation & Licensing
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Launch the installer by double-clicking it. Windows may ask if you trust us first.

Click Next, then click Install. The installation will proceed. When it completes, you'll see this:

If you have never installed LightBurn on this computer before, you might need to install drivers. This is not necessary when updating an existing
installation.

The FTDI driver is mostly used by DSP controllers, like Ruida and TopWisdom.

The EzCad2 driver is used by supported Galvo devices using EzCad2 boards.

That's it! Locate the LightBurn icon to launch the program.

To install LightBurn on an ARM-based Mac (using an M1 chip or later), you must have Rosetta installed.

In most cases, Rosetta is automatically installed on ARM-based Macs, and manual installation is unnecessary. If Rosetta is not installed, you'll be
prompted to install it when you attempt to open LightBurn. 

Installing LightBurn on macOS is accomplished the same way as most macOS software. After downloading the DMG file, open the file
(typically by double-clicking) and drag LightBurn into your Applications folder. As long as you have version 1.2.00 or later, LightBurn should
be ready to use. If you're using an older version, please see the information below for an additional step you'll need to take.

Versions before 1.2.00 were not notarized to be recognized by your computer as coming from a trusted developer. If you installed an older
version, you'll need to follow the steps below to allow your computer to run the software:

To Install the LightBurn application:

Double-click the LightBurn.dmg file to mount the disk image

Drag the LightBurn application into your applications folder

Eject the LightBurn disk image, or drag it to the trash bin

When launching LightBurn for the first time:

Open a Finder window

Browse to the Applications folder

Hold the Control key and click the LightBurn icon, or right-click or two-finger tap the icon

Choose Open from the menu

When macOS asks if it should open the program, say yes, and it will be listed as an exception in your launcher. From then on you can just launch
the application normally.

Video walkthrough for macOS installation

LightBurn is tested on Ubuntu Linux, and current releases are officially supported on Ubuntu 20.04 and 22.04.

Ubuntu 18.04 users unable to upgrade to a more recent version should download LightBurn 1.2.01, the last release compatible with their
operating system.

Ubuntu 20.04 users can use any of the installation methods described below.

Ubuntu 22.04 users will need to use LightBurn's new AppImage installer.

Please see Linux Installation for more information.

Windows Installation macOS Installation Linux Installation

Installing Drivers

• 

• 

Note

macOS Notarization Bypass Guide (fixing the 'unable to check it for malicious software' warning)

1. 

2. 

3. 

1. 

2. 

3. 

4. 

5. 

• 

• 

• 
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